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Introduction: single camera vs. multi-camera

Single camera productions - shows made using a camcorder - use only one 
camera to capture the action. If coverage from different angles is needed, then 
the action must be repeated while the camera records multiple takes from dif-
ferent angles. These takes are then combined together as one cohesive action 
by editing afterward. 

Multi-camera productions rely on a switcher, which is used to select between several cameras covering live 
action. This type of production lends itself to covering live events - things where repeating the action or editing 
would be impractical, such as musical performances, interviews and other demonstrations. Shows produced in 
the studio can either be aired live, while recording is taking place, or recorded and then edited and aired later. 
Whichever method is used, multi-camera productions are typically recorded without any re-takes and very 
little or no editing is done afterward. 

Studio Overview

The following are the major elements used in the studio:

Set: The set is the area in front of the camera where the action of the show takes place. Set pieces can in-
clude chairs, tables, lecturn, and other furnishings.

Cameras:  Three cameras feed into the switcher, which then determines what is recorded. The cameras 
themselves do not directly record any footage. 

Program monitor: Large television in the studio that displays the program feed, i.e. what is being recorded. 
The program monitor is a useful reference for the host of a show to know what will be seen by the audience 
and which camera is selected.

Audio monitor: a speaker which sits on the floor and can be used to send sound out to the set. This can 
be used as a vocal monitor for a singer, or to playback sound from a pre-edited video that may rolled into the 
show.

Snake: a large cable that runs along the wall and ends in a box with all of the microphone connections to run 
sound into the control room. The panel has 8 mic inputs that correspond to inputs on the audio mixer in the 
control room.

Control room: A small, enclosed room next to the studio where switching and recording takes place. Inside 
the control room are the switcher, graphics computer, camera control units, recorders. A large window allows 
the crew in the control room to see the set. An intercom system, consisting of headsets with microphones, 
allows the director to communicate with the crew in the studio. 

Switcher: Integrates all of the sources in a studio production. The switcher allows the director to instanta-
neously select between any of the inputs (3 cameras, DVD player, computer and presenter), or even combine 
them. Switching a production is like “live editing”; rather than assembling all the separate camera angles in 
the edit suite after the fact, the studio show is produced “live”, as camera angles are selected in real time as it 
happens (see picture on next page).
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During a production, the only thing that matters is whichever source is selected or “live.” Other sources 
not selected for live output will not be seen in the final program. For example, if camera 1 is live, then 

cameras 2 and 3 are free to move about and reposition until they are selected. 

Crew Positions

On a single-camera shoot, the crew can be as small as one person; however, a studio production usually 
requires a team of several people to help pull everything together, since it’s essentially produced “live”.

Producer: The manager of the television production. Responsible for program concept, structure, content and 
for arranging talent, crew, equipment check-out, air times, and getting the production started and finished. 

Talent: The people in front of the cameras: performers, hosts, or guests.

Director: The director is responsible for decisions concerning shot compo-
sition, camera movement, etc. The director typically operates the switcher 
and commands the camera operators and floor director over a headset 
intercom while a production is being recorded. The director will call out all 
actions to be taken by the crew.

Camera Operator: The person running a camera. If no camera movement 
is needed, cameras can be set and  locked down before recording begins 
to reduce the number of camera operators needed.

Floor Director: The floor director’s job is to communicate between the talent and director. Wearing a head-
set, they will stand beside a monitor showing the program in the studio and pass on the director’s orders to 
the talent, either verbally or with hand signals. Usually the floor director’s biggest function is to let the talent 
know when to start/stop and how much time remains in the show. The floor director may also function as a 
camera operator.

Audio Operator: The person responsible for setting up and monitoring the sound in a production. During 
production, they run the audio mixing board and play any music needed in the show.

C.G./Graphics Operator: Creates titles on the character generator, which is a special computer that outputs 
graphics to be superimposed over the video. Usually all graphics are typed in before recording begins. The C.G. 
Operator’s job during the production is then to bring in the names and titles at the appropriate time in the show 
when called for by the director. 

2

SWITCHER

Final output:
• Live on air
• File on SD card
• DVD
• Stream online

Camera 1
Camera 2
Camera 3
Computer
Presenter
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Director’s Commands

The Director will give commands to be carried out by everyone on the crew. In the control room, the director 
will give a preparatory “Ready to . . .” command followed by the “Do it” command (e.g.: “Take”, “Zoom in”, 
etc.). Do not execute the operation until the “do it” command is given by the director.  Example: “Ready to dis-
solve to camera 2, hold 2, dissolve to two.”

“Stand by” or “Ready”:  is followed by a visual cue. “Ready Camera 1 - Take 1.”  You are alerting others 
involved in the program what is going to happen next.

“Take”: is a direct cut between two video sources.

“Key”: to superimpose a graphic title onto the video.

“Cut”:	 means everyone stop what they’re doing.

“That’s a rap”: means the shoot is finished.

“Strike”: tear down the set, pack up equipment and put everything away.

Directing Tips

• Try to stay one step ahead of yourself, and always have your next move planned. 

• Always be courteous to everyone on the crew. 

• Crew postions can be consolidated if you don’t have enough people. One person in the studio can act as 
floor director and move between all three cameras. Cameras can be locked down unattended if they don’t need 
to be repositioned. For simple productions, the director single-handedly can run everything in the control room, 
with enough preparation.

• More live production = less post production; more pre/post production = less live production. The more ele-
ments you produce in editing, before or after the studio production, the less work you’ll have to perform “live”.

• Typically the most complicated directions must be given during the opening and closing of a program. In 
between the open and close, directing may be as simple as repeatedly switching between cameras 1 and 3 
while following a conversation. 
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Floor Director’s cues

In order to guide the talent in the studio, the Director relays his instructions through the Floor Director. The 
Floor Director listens to the director through the headset, and then visually gives cues to the talent, so that 
A) the talent does not have to wear headsets while on camera; and B) the audio portion of the show is not 
disrupted by crew talking out loud on the set.

Slow down Speed up/Wrap it upStand by Cue

1 Minute 5 Minutes 2 MinutesHalf Way

Setting Up The Studio

To set up for a shoot:
1. Prepare the set
2. Set up lights
3. Set up cameras
4. Set up microphones 

To prepare the set, get chairs and tables in place. You are free to use any of the props and furniture pieces in 
the storage room. When finished, please return all props and set pieces to their original position in the storage 
room. Note that the path to the exit must be kept clear.

For ease of lighting, position the set in the center of the studio. Position the program monitor so that the host 
can see it without having to turn their head.
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Lighting 

Before you run cameras or microphones, it is best to get lights in place so you don’t have to run the ladder 
over cables. Lights are turned on and off at the lighting dimmer board. Find the numbers of the lights you need 
and turn only those lights on, using the faders to control intensity.

Key Light: provides the main source of illumination 
on the subject.  The key light is positioned in front 
of and above the subject at 45 degree angles.  The 
key light creates the modeling necessary to create a 
three dimensional look. 

Fill Light: provides general diffused or soft illumina-
tion for scenes to soften the shadows and cut down 
the contrast created by the key light. Generally, a 
lighting ratio of 2 to 1 is desired: the key light should 
be twice as strong as the fill light. However, the best 
guide for proper lighting is what the picture looks like in 
the camera and on the monitor.

Back Light (or hair light): falls from above and to 
the rear, onto the head and shoulders of the subject. 
The back light outlines the subject and makes them 
stand out from the background. A back light on one 
person can also serve as the fill light for the other per-
son (see diagram).

Background light: may be used to intensify the background illumination level or to create a special mood.

Gobo: A cut-out silhouette placed in front of a spot light, used to create a shape or pattern on the wall.
 
The lighting dimmer board controls all of the light. Each light is plugged into a numbered power outlet that 
corresponds to a fader number on the dimmer board. Bring up each light individually, aim it, bring it back 
down, and go on to the next one. The FLOOD position is normally used on all lights. Use the barn doors to keep 
excess light from spilling on the back wall. When finished, turn on all the lights you’re going to use. Be sure to 
turn off the overhead flourescent lights.

If you are chroma-keying, the background light your subjects as you normally would, then light the back wall 
as evenly as possible using the flood lights. Make sure to only light the wall with the flood lights, and mask off 
the ceiling and floor with the barn doors. 

Take care to use gloves when handling lights that have been on - they will be very hot! If you move lights from 
their original position, be certain to reattach the safety cable. DO NOT hang lights from the water pipes. 

Key lights are 750 watts, indicated by the white stripe; back lights are 500 watts, indicated by the blue stripe. 
Back lights may be scrimmed off with spun-glass. Scrim the side of the light used as back light, while leaving 
the other side, used as fill light, unfiltered.

SUBJECT 1 FILL
SUBJECT 2 BACK

CAM 1

KEYKEY

SUBJECT 2 FILL
SUBJECT 1 BACK

1 2

CAM 2
CAM 3
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Camera

Determine the postion of the cameras. Typically:
• Camera 1 will shoot the host
• Camera 2 will be used for a wide shot of the entire set
• Camera 3 will shoot the guest(s)

Be careful not to step on or puts kinks in the camera 
cables. Remove the lens cap and store it in the hand 
strap on the side of the lens. The viewfinder may be re-
positioned. Notice the large red tally light that indicates 
which camera is selected.

Zoom/Focus
• Use the remote zoom control on the right handlebar to zoom. 
• Use the remote focus control on the left handlebar to adjust focus: zoom all the way in on the eyes of the 
subject, turn the focus ring, and then zoom out to frame up the shot. Focus is determined by the distance 
between the lens and the subject. 
•All other camera adjustments are made using the camera control units in the control room.

Camera Operators
• Pay close attention to the commands of the director.
• Execute commands quickly and accurately.
• Never move your camera until you are sure another camera has been selected.
• Be aware that the camera viewfinder shows more than the program monitor, so the director always 	    
makes the final decision about composition.
• If you have to talk, do it quietly.
• With experience, you will begin to anticipate the needs of the director with a minimum of cues.
• Any cameras not requiring movement or repositioning during a production may be locked down and do not 
require a camera operator.



Composition

Usually, scenes should begin with a wide shot to establish the setting. Then, cut in to a medium shot, then to 
close-ups for details.

7

Wide Shot Medium Shot Medium Close Up

Close Up Extreme Close Up

Lead Room, Nose Room, 
Look Space or Talk Space

Two Shot Three Shot

Rule Of Thirds: 
Imagine the screen is divided into a 3 x 3 grid. 
Place the center of interest near one of the 
four cross-points for a stronger composition.

Head Room
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Tripod

Tripods are typically placed so that the cameras are at eye 
level with the subject. Use a second person to help steady the 
camera while you adjust the legs if you want to raise or lower 
the tripod.

Pan: turning the head of the tripod horizontally, left or right. 
“Pan right” or “pan left.” Lossen the pan lock prior to pan-
ning.

Tilt: turning the head of the tripod vertically, up or down. 
“Tilt up or tilt down.” The tripod’s tilt lock must be loosened 
when tilting. If you step away from the tripod, always tighten 
the tilt lock to secure the camera. Use the tilt drag to control 
the amount of resistance on the tilt.

Zoom: changing the focal length of the lens from wide angle 
to telephoto. “Zoom in” (tighter) or “zoom out” (wider).

Dolly: rolling the tripod and camera toward or away from the 
subject. “Dolly in” (move closer) or “dolly out” (move away).

Truck: rolling the tripod and camera to the left or right of the 
subject. “Truck left” or “truck right.”

Pan and tilt locks only need to be finger tight - do not over tighten them.

Microphones

Two types of microphones may beused in the studio: clip-on (or lavaliere) and handheld. 
The clip-on mic is normally used for interviews. It should be clipped onto a lapel or shirt 
placket about 6” below the chin, and made to look as inconspicuous as possible. Each per-
son should be miked individually. Set the boxes on the floor behind the chairs and drape the 
microphone element on the back of the chairs.  Be sure to turn the mics on.

The handheld mic is a good all-purpose mic to use for some 
talk show formats and musical performances. Again, the mic should be posi-
tioned as closely as possible to the source, without blocking the talent’s face. 

Plug the female end of the XLR cables into the microphones and run the cables to 
the back wall as one straight line. All audio cables should be dressed neatly and 
run over to the patch panel on the wall. Note how the numbers on the jacks cor-
respond to channels on the mixer in the control room.



Setting Up The Control Room

1. Power up: turn on the master power switch in the equipment rack.
2. Adjust the iris of each camera.
3. Test microphones. 
4. Prepare other materials. Load any slides or photos to be used, open graphics and check titles.
5. Prepare recording media

Switcher Overview

The Multi-View monitor shows all input sources, as well as Program and Preview selections, all in one display. 
The PGM box on the top right shows what is being taken or recorded “live”; this can also be monitored on the 
rack, above the DVD recorder.

Input sources:
	 1 = Camera 1
	 2 = Camera 2
	 3 = Camera 3
	 4 = (empty)
	 5 = (empty)
	 6 = (empty)
	 7 = Mac 
	 8 = Presenter

When an input is selected for PGM, its preview box is outlined in red to indicate that it is “live”.
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To switch between sources, press the appropriate source button in the PGM bus to cut to that source live. Or, 
in the Transition area, press the CUT button to cut between the PGM bus and another source selected in the 
PST bus. 

Transitions

To dissolve between sources: 
1. Select the source you want to dissolve to in the PST bus.
2. Push the MIX and BKGD buttons so they light up.
3. Push the fader bar, or press AUTO to dissolve from PGM to PST (auto = 1 second transition length).

The “FTB” button creates a Fade To Black.

With MIX selected, the fader bar or AUTO button creates a dissolve. When WIPE is selected, a transition 
selected in the Wipe Pattern Area will be used instead.

To perform a wipe or other transition:
1. In the transition area, make sure both BKGD and WIPE button are lit.
2. In the wipe pattern area, press the BKGD PATT button repeatedly to select between Wipe, Squeeze, Slide or 
3D. Note the lights for each in the PAGE area.
3. Select a wipe pattern from Wipe Pattern Area.
4. Push the fader bar, or press AUTO to wipe from PGM to PST (auto = 1 second transition length).
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You can also add a border or a soft edge to your transition:
1. Press FUNC + WIPE (2) to access the wipe menu.
2. Turn the F2, F3 or F4 knobs accordingly to adjust.

Chroma Key

Chroma key is a technique for mixing two images together, in which a color/background from one image is 
removed (or made transparent), revealing another image behind it. The studio walls are painted blue to allow 
for chroma keying. If lit properly, the wall can be keyed out and a different background placed behind a subject 
sitting in front of the camera.

To set the switcher up for a chroma key:
1. In the AUX BUS DELEGATION area, press KEY. Make sure the button is lit up in orange. If it is lit up in green, 	 
	 press it again to make it orange.
2. Select the foreground image in the AUX bus. This should be the camera with the most blue background
	 visible, usually camera 2. Then select the background image in the PGM bus.
3. In the transition area, press the KEY button, and move the fader bar up so that the KEY ON light is lit in red. 

You should now see a chroma-keyed image in program. 

You can cut between all three cameras by switching on the AUX bus. You can change the background by 
selecting a different input on the PGM bus. To transition out of a chroma key (i.e., cut from a camera with a 
chroma-keyed background, to standard background):
	 • In the transition area press  BGD + KEY so they both light up
	 • In the PST bus, select the source that you want to cut to
	 • Press CUT or AUTO. Continue switching on the PGM bus like normal.

PLEASE REMEMBER TO TURN THE KEY OFF WHEN FINISHED!!

If the KEY ON light is lit up in red, that means the Chroma Key is still active. To turn off Chroma Key:
1. Press KEY button so it is lit up (orange).
2. Move fader bar to the opposite position.
3. Press BKGD button so it is lit up (orange).

Freeze Frame

If you want to freeze an input: 
1. In the wipe pattern area, Press FUNC + FREEZE (6)
2. In the menu, turn the F1 knob to select 2/2
3. Turn the F2 knob to select which source to freeze (INPUT 1,2,3,5,6,7 or 8)
4. Push F5 knob down to freeze. The input is now frozen and stored in the same input. Push F5 again to release 
the freeze.

You can also freeze the image from the Samsung Presenter by pushing the FREEZE button on the presenter. 
This can be useful when you have a series of images to to use one after another.
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Picture-In-Picture

Picture-in-picture allows you to use one source shrunk to an inset box, over top of another source.
1. Select the source that you want as the background in the PGM bus; select the source that you want in the 
box on the AUX bus.
2. In the AUX BUS DELEGATION area, press PinP.
3. In the wipe pattern area, press FUNC + PinP (8) to access the PinP menu.
4. In the menu (1/6), turn F5 to turn PREVIEW ON. 
5. OPTIONAL: Turn F1 to get to menu 2/2; turn F2, F3 or F4 adjust the edge border, width and softness.
6. In the positioner area, turn the Z knob to adjust size; use the positioner joystick to adjust position on screen.
7. Once you have the picture-in-picture looking how you want it in preview, push the PinP button the transition 
area to bring it up in program. 

Control Room Components

Camera Control Units (CCUs): Each camera has a camera contol unit. These units supply power to the 
cameras, intercom connection and controls for calibration. Below is an overview of the most commonly-used 
controls.

Audio Mixer: controls the volume for all sound sources. Channels are labeled and correspond to the num-
bered mic inputs on the studio wall. Each source has its own channel on the mixer, with a volume fader and 
MUTE button. The two Master Faders control the volume for the entire mix. 
• Each channel can be sent out to the audio monitor in the studio, if the talent needs to hear it. At the top of 
the mixer, turn the AUX dial to adjust the volume going to the audio monitor.
• The meters display how loud the mix is. Levels should be as high as possible, without going into the red or 
exceeding +2 on the meters. Speaker volume can be adjusted without affecting the recording level.

IRIS
The AUTO/MANU button should always be lit up for manual iris control.

• Turn the dial toward “CLOSE” to reduce the amount of light entering the 
camera, and make the image darker. 

• Turn the dial toward “OPEN” to increase the amount of light entering the 
camera, and make the image brighter.

Set the iris level of each camera so that all 3 match each other as closely as 
possible.

* PLEASE NOTE *
The cameras have been carefully 
calibrated. Please do not mess 
with any controls other than the 
Iris knob. If you are having 
problems with a camera’s image, 
please ask a staff member for 
help.

TALLY
Red light indicates that 
this camera is selected 
for live output, or “hot”.



Intercom: controls the headsets for the crew. 
• Press the TALK button to talk to the crew. 
• Press and hold the STAGE ANNOUNCE button to make announcements over the audio monitor in the studio

Mac Mini: this computer can be used for a variety of tasks:
	 PowerPoint presentations: Slide shows created in PowerPoint may be used. A remote presenter 
control is available to advance slides. The remote works from inside the studio, so slides may be controlled by 
a person while on camera. 

	 Digital photos: JPEG, TIFF, GIF, PSD formats in RGB color. Size should be at least 1024 x 768 or larger 
in order to display full-screen. Files should be properly named /numbered to run in the order desired. First, copy 
pictures into iPhoto. Once in iPhoto, press the full screen button to display them full screen. Use the < > ar-
row keys on the keyboard to advance to the previous/next photo.

	 Video Files: most common formats should work, including HD videos. If you plan to use videos on the 
web (such from YouTube), it is striongly recommended to download and save the videos, rather than try to 
play/stream them live during recording.

PowerPoint presentations, digital photos, videos and any other files may be brought in on: 
• USB thumb drive or “flash” drive. Drives may be formatted for PC (MS-DOS, FAT32) or Mac.
• Hard drive: USB, formatted for PC (MS-DOS, FAT32) or Mac.
• All data must be transferred using one of the media listed above and run from the in-house Mac computer. 
Outside laptops CANNOT be connected to the studio.

	 iTunes: contains 25 CDs from AccessVision’s music library. Music can be looped by clicking the 
repeat button. Also, Jumpbacks animated backgrounds, as well as AccessVision’s disclaimer, can be used in 
your show by clicking the full screen button.

	 Web sites: An internet connection using Safari and Firefox web browsers, running on a Mac, are avail-
able. Whatever can be displayed on a computer screen, may used in a studio production. 

Print materials: Use the presenter to display brochures, photo prints, flyers, etc. Maximum size: 11” wide x 
8.5” tall. Horizontal material with a matte finish works best. Use the Zoom + - control to frame the material as 
needed. Use the FREEZE button to hold one image while you change it out for the next image.

All materials should be prepared in advance of recording a live show. The more prep work that is 
done ahead of time, the smoother things will go during recording. 

13



14

Recorders: The studio has 2 options for recording your program:
1. Record to SD card - do this if you plan to edit your show after recording
2. Record to DVD - do this if you want to put your program on the air as-is and do not plan to edit. 

If you are not sure whether you will edit or not, record to BOTH SD card and DVD. Note that AccessVision only 
airs programs as files; DVDs cannot be directly played on the air without first converting it to a file. 

ALWAYS MONITOR WHAT YOU ARE RECORDING!

The rack-mounted video monitor is set up to display exactly what is being recorded on the DVD recorder. The 
SD card recorder has a built-in video display and audio meters to monitor recordings. 

Typically, the DVD recorder is set to fit 120 minutes on a DVD. You can monitor the elapsed record time by 
repeatedly pressing the STATUS button on the DVD Recorder remote until the record time is displayed. Note 
that DVDs must be formatted prior to recording and may also need to be finalized after recording.

To format a DVD:
1. When an unformatted DVD is inserted, “This disc is incompatible” message is displayed on screen. Press 
the center OK button on the remote.
2. Press the remote’s FUNCTIONS button. Then press the down arrow to go to “Other Functions” and press OK.
3. Press the down arrow again to go to “DVD Management” and press OK.
4. Press OK to select “Format Disc (DVD)”; 
5. Press the left arrow < to select “Yes” and hit OK; press the left arrow < again to select “Start” and hit OK.

To finalize a DVD:
1. Press the remote’s FUNCTIONS button. Then press the down arrow to go to “Other Functions” and press OK.
3. Press the down arrow again to go to “DVD Management” and press OK.
4. Press OK to select “Finalize Disc (DVD)”; 
5. Press the left arrow < to select “Yes” and hit OK; press the left arrow < again to select “Start” and hit OK.

Note: DVD+RWs do not need to be finalized. 



Character Generator

 
Use on-screen text graphics to show a guest’s name, title, organization. Also consider displaying any contact informa-
tion that will be mentioned on the show: a phone number, location address, web site URL, important dates, etc.

15



Graphics Basics

Double-click the GenCG shortcut to start the program.

• Use the Type tool to type. See the Attributes tab at the bottom left of the screen to change font, size, etc.

• Use the Shape tool to draw shapes, such as a rectangle to put behind a lower third title.

• Use the Front, Back Forward and Backward buttons in the shortcut toolbar to arrange the order of layers.

• Add in/out transitions for titles in by clicking the ! box next to each page in the page list, and choosing a 
transition from the Effects tab. A simple dissolve or fade transition is done by selecting the effect that has an F 
for its icon.

• Once you get the first graphic created, right-click on the page in the Page List and select “Copy Page”; then 
right-click on the next empty page in the list and select “Paste Page”. Now simply type over the lettering to 
make a matching new title, without having to reset all of the formatting, etc.

• To play your graphics on-air, press the Play button in the Playback Control area. You can also play a single 
page by clicking the page in the Page List, and then pressing the CUT button. Or use the left & right arrow keys 
and the Enter button on the keyboard to navigate & display pages.

• Save your script by going to the File menu and selecting Save. Please save graphics in the Studio Graphics 
folder.

To create rolling credits:
	 1. Choose Rolling in the Page Mode pulldown
	 2. Type all credits on one page; use the scroll bar to scroll up and down once the list of credits 
	       becomes too long to fit on the page.
	 3. Adjust the speed of the roll in the Effects tab.
	 4. Be sure to create a blank page after the rolling credits page.

Using logos and other graphics in your titles
	 1. Create your graphics in an image-editing application, such as Adobe Photoshop. Create an alpha 		
	    channel for the image and it save as a TIFF file with transparency. 
	 2. Copy the image to the Studio Graphics folder.
	 3. Open GenCG. In the Insert menu, select “Insert Image”. Grab the corner of the image and drag to  
	   resize it. Hold the SHIFT button down as you drag to avoid stretching the image.

When finished using the graphics system, press the CLEAR button to clear out titles before 
closing GenCG. Otherwise, titles will remain on screen, even after the program has been exited.

Please work through the short GenCG workshop tutorial to create & play lower thirds.
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GenCG Shortcut Toolbars

GenCG tool bars are a convenient way of accessing all of the capabilities that GenCG has to offer.  Getting familiar 
with them can maximize the productivity of the created GenCG documents.  Below is a description
of what each icon means.

   1.  2.   3.     4. 5.   6.    7.    8.     9.  10.   11.  12. 13.14.   15. 16. 17.18. 19.  20.   21.  22. 23.  24.  25. 26. 27. 28. 29. 30.  31.

  32.                     33  34. 35. 36. 37.  38. 39. 40.  41.    42.   43.     44.  45.46. 47. 48. 49. 50.

1.  New:  Create a new GenCG document. 26. Scheduler Suite:: Schedule documents to run automatically at different times.

2.  Open:  Open a previously saved GenCG document. 27. Option: Opens the option menu.

3.  Save:  Save the currently opened document. 28. Take In: Take selected page directly through the preview and program output.

4.  Cut:  Delete a selected object in the create & edit screen with means of                       
pasting it elsewhere.

29. Take Out: Immediately clear selected page through the program output,

5.  Copy:  Copy a selected object on the create & edit screen. 30. Stop:  Stops an animation or page mode immediately from program output if 
previously used take in.

6.  Paste:  Paste a currently cut or copied object onto the create & edit screen. 31. Graphic Animation: is option is not available.

7.  Print:  Go to the print setup page for prompt printing. 32. Page Mode: Select one of multiple modes that pages will be displayed with.

8.  Delete: Delete a selected object on the create & edit screen. 33. Select: is GenCG cursor can select any object on the page.  It can also 
manipulate any object as well.  

9.  Undo:  If a mistake is made on an object in the create & edit screen, go 
back to previously positioned state of the page.

34. Text: Insert text on the create & edit screen.  After selected, simply left click the 
create & edit screen to type.

10. Redo:  Re-apply a previously undo action. 35. Shape: Insert shapes on the create & edit screen.  After selected, simply left click 
the create & edit screen to type.

11. Object Lock: Enables selected objects to be locked.  Locked objects 
cannot be moved or changed.

36. Insert Image: Insert images into the opened document.  GenCG supports 
jpeg, bitmap, targa, png, tif, and gif images.

12. Object Unlock: Enables locked objects to be functional. 37. Insert Background: Insert a stabilized image that cannot be edited easily.

13. Bundle Attributes: If multiple pages are selected in the page list and a 
single object is selected, change all objects attributes in all pages 
simultaneously.

38. Align Left: If text is selected on the create & edit screen, the text can be aligned to 
the left if it has multiple rows.

14. Update Page List: If bundle attributes is selected, all pages in the page list 
are to display the updated information.  For older systems, it is 
recommended to not activate this function.

39. Align Center: If text is selected on the create & edit screen, the text can be aligned 
to the center if it has multiple rows.

15. First Page: Go to the first page of the page list. 40. Align Right: If text is selected on the create & edit screen, the text can be aligned 
to the right if it has multiple rows.

16. Previous Page: Go to the previous page of the page list. 41. Screen Align: Aligns objects within the video safe title area.

7. Next Page: Go to the next page of the page list. 42. Area Align: Aligns objects within the X and Y axis.

18. Last Page: Go to the next last page of the page list. 43. Object Align: Aligns all selected objects with any specified object.

19. Mask Effect: Creates an area in the create & edit screen in that, everything 
outside that area is masked and cannot be seen on-air.

44. Match Width: If multiple objects are selected, the width of all the objects are 
matched by the width of the main selected object. 

20. Live View: Editing pages in GenCG can be viewed directly on-air in real 
time.

45. Match Height:  If multiple objects are selected, the height of all the objects are 
matched by the height of the main selected object.

21. View Text: View the current document in a standard text file.  Document 
cannot be edited.

46. Match Width & Height:  If multiple objects are selected, the width and height 
of all objects are matched by the width and height of the main selected 
objects.

22. Multiple CG Page List:  View two GenCG page lists (CYNERG series) 47. Front: If multiple objects collide, it will bring the selected object to the front.

23.  Controller:  Run two Playback Controls. (CYNERG series) 48. Back: If multiple objects collide, it will bring the selected object to the back.

24. Church DB: Function not available 49. Forward: If multiple objects collide, it will bring the selected object forward.

25. GenlockVGA Control: Controls internal Genlock with test patterns. 50. Backward: If multiple objects collide, it will bring the selected object backward.

e Basics    B.2
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Summary: Setting up for a shoot

In the Studio:

1. Prepare the set. Get chairs and tables in place. Position the set in the center of the studio. 

2. Set up lights. Turn on each light individually, aim it, turn it back off, and go on to the next one. When 
finished, turn on all the lights you’re going to use. Use gloves when handling hot lights! 

3. Power up. Turn on the master power switch in the Control Room to supply power to the cameras. Turn on 
the program monitor in the studio and punch up camera 2 on the switcher so that you can see what your light-
ing looks like as you work.

4. Set up cameras. Zoom all the way in on the eyes to set focus, then zoom out to frame up the shot. Be 
aware of headroom and noseroom. Be sure to tighten down the Tilt Lock when stepping away from the 
cameras.

5. Run microphones and cables. If using lavalieres, set the boxes on the floor behind the chairs and drape 
the microphone element on the back of the chairs. Plug the female end of the XLR cables into the microphones 
and run the XLR cables to the back wall as one straight line. Keep the line going neatly along the wall all the 
way over to the patch panel. Be sure to turn the mics on.

In the Control Room:

6. Adjust the iris of each camera. With the lights set and on, try to make all three cameras match each 
other.

7. Test microphones. Bring up each channel on the audio board individually and have the talent speak at a 
normal level. Make sure the audio meters do not peak into the red. Once the level is set, leave the fader up and 
MUTE the channel. Move to the next channel and repeat.

8. Prepare other materials. Load any slides or photos to be used, open graphics and check titles.

9. Prepare the recording. Format the DVD

NOW YOU’RE READY TO RECORD YOUR SHOW...

When finished, please lock down cameras and replace lens caps. Neatly wrap mic cables and return mics to 
the cabinet. Return all props and set pieces to their original position in the storage room. The path to the door 
must be kept clear since it is a fire exit. 

Jason Augenstein, Projects Coordinator
jason@accessvision.tv
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